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ABSTRACT These instructions give you guidelines for preparing papers for the IEEE Journal of
Microwaves. Use this document as a template if you are using Microsoft Word 6.0 or later. Otherwise, use
this document as an instruction set. The electronic file of your paper will be formatted further at IEEE.
Paper titles should be written in uppercase and lowercase letters, not all uppercase. Avoid writing long
formulas with subscripts in the title; short formulas that identify the elements are fine (e.g., “Nd–Fe–B”).
Do not write “(Invited)” in the title. Full names of authors are preferred in the author field, but are not
required. Put a space between authors’ initials. The abstract must be a concise yet comprehensive reflection
of what is in your article. In particular, the abstract must be self-contained, without abbreviations, footnotes,
or references. It should be a microcosm of the full article. The abstract must be between 150–250 words.
Be sure that you adhere to these limits; otherwise, you will need to edit your abstract accordingly. The
abstract must be written as one paragraph, and should not contain displayed mathematical equations or
tabular material. The abstract should include three or four different keywords or phrases, as this will help
readers to find it. It is important to avoid over-repetition of such phrases as this can result in a page being
rejected by search engines. Ensure that your abstract reads well and is grammatically correct.

INDEX TERMS Enter key words or phrases in alphabetical order, separated by commas. For a list of
suggested keywords, send a blank e-mail to keywords@ieee.org or visit
http://www.ieee.org/organizations/pubs/ani prod/keywrd98.txt

I. INTRODUCTION
This document is a template for Microsoft Word versions
6.0 or later. If you are reading a paper or PDF version
of this document, please download the electronic file,
Word template, from the IEEE Template Selector at
https://template-selector.ieee.org/ so you can use it to
prepare your manuscript. If you would prefer to use LaTeX,
download IEEE’s LaTeX style and sample files from the
same Web page.Use one space after periods and colons.
Hyphenate complex modifiers. You can also explore using
the Overleaf editor at https://www.overleaf.com/blog/278-
how-to-use-overleaf-with-ieee-collabratec-your-quick-guide-
to-getting-started#.Vp6tpPkrKM9 If you use MS Word
template select style from style panel.

If your paper is intended for a conference, please contact
your conference editor concerning acceptable word processor
formats for your particular conference.

II. GUIDELINES FOR MANUSCRIPT PREPARATION
When you open trans jour.docx, select “Page Layout” from
the “View” menu in the menu bar (View | Page Layout),
(these instructions assume MS 6.0. Some versions may have
alternate ways to access the same functionalities noted here).
Then, type over sections of trans jour.docx or cut and paste
from another document and use markup styles. The pull-
down style menu is at the left of the Formatting Toolbar at
the top of your Word window (for example, the style at this
point in the document is “Text”). Highlight a section that
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you want to designate with a certain style, and then select
the appropriate name on the style menu. The style will adjust
your fonts and line spacing. Do not change the font sizes or
line spacing to squeeze more text into a limited number of
pages. Use italics for emphasis; do not underline.

To insert images in Word, position the cursor at the
insertion point and either use Insert | Picture | From File
or copy the image to the Windows clipboard and then Edit
| Paste Special | Picture (with “float over text” unchecked).

IEEE will do the final formatting of your paper. If your
paper is intended for a conference, please observe the
conference page limits.

A. ABBREVIATIONS AND ACRONYMS
Define abbreviations and acronyms the first time they are
used in the text, even after they have already been defined
in the abstract. Abbreviations such as IEEE, SI, ac, and dc
do not have to be defined. Abbreviations that incorporate
periods should not have spaces: write “C.N.R.S.,” not “C. N.
R. S.” Do not use abbreviations in the title unless they are
unavoidable (for example, “IEEE” in the title of this article).

B. OTHER RECOMMENDATIONS
Use one space after periods and colons. Hyphenate complex
modifiers: “zero-field-cooled magnetization.” Avoid dangling
participles, such as, “Using (1), the potential was calculated.”
[It is not clear who or what used (1).] Write instead, “The
potential was calculated by using (1),” or “Using (1), we
calculated the potential.”

Use a zero before decimal points: “0.25,” not “.25.” Use
“cm3,” not “cc.” Indicate sample dimensions as “0.1 cm ×
0.2 cm,” not “0.1 × 0.2 cm2.” The abbreviation for “seconds”
is “s,” not “sec.” Use “Wb/m2” or “webers per square meter,”
not “webers/m2.” When expressing a range of values, write
“7 to 9” or “7-9,” not “7∼9.”

A parenthetical statement at the end of a sentence is
punctuated outside of the closing parenthesis (like this). (A
parenthetical sentence is punctuated within the parentheses.)
In American English, periods and commas are within quota-
tion marks, like “this period.” Other punctuation is “outside”!
Avoid contractions; for example, write “do not” instead of
“don’t.” The serial comma is preferred: “A, B, and C” instead
of “A, B and C.”

If you wish, you may write in the first person singular
or plural and use the active voice (“I observed that ...” or
“We observed that ...” instead of “It was observed that ...”).
Remember to check spelling. If your native language is not
English, please get a native English-speaking colleague to
carefully proofread your paper.

III. MATH
If you are using Microsoft Word, use either the
Microsoft Equation Editor or the MathType add-on
(http://www.mathtype.com) for equations in your paper
(Insert | Object | Create New | Microsoft Equation or

MathType Equation). “Float over text” should not be se-
lected.

A. EQUATIONS
Number equations consecutively with equation numbers in
parentheses flush with the right margin, as in (1). First use
the equation editor to create the equation. Then select the
“Equation” markup style. Press the tab key and write the
equation number in parentheses. To make your equations
more compact, you may use the solidus ( / ), the exp
function, or appropriate exponents. Use parentheses to avoid
ambiguities in denominators. Punctuate equations when they
are part of a sentence, as in

(1)

Be sure that the symbols in your equation have been de-
fined before the equation appears or immediately following.
Italicize symbols (T might refer to temperature, but T is the
unit tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),”
except at the beginning of a sentence: “Equation (1) is ....”

IV. UNITS
Use either SI (MKS) or CGS as primary units. (SI units
are strongly encouraged.) English units may be used as
secondary units (in parentheses). This applies to papers in
data storage. For example, write “15 Gb/cm2 (100 Gb/in2).”
An exception is when English units are used as identifiers in
trade, such as “31/2-in disk drive.” Avoid combining SI and
CGS units, such as current in amperes and magnetic field in
oersteds.

The SI unit for magnetic field strength H is A/m. How-
ever, if you wish to use units of T, either refer to magnetic
flux density B or magnetic field strength symbolized as µ0H .
Use the center dot to separate compound units, e.g., “A·m2.”

V. SOME COMMON MISTAKES
The word “data” is plural, not singular. The subscript for the
permeability of vacuum µ0 is zero, not a lowercase letter
“o.” The term for residual magnetization is “remanence”;
the adjective is “remanent”; do not write “remnance” or
“remnant.” Use the word “micrometer” instead of “micron.”
(unless you really mean something that alternates) A graph
within a graph is an “inset,” not an “insert.” The word
“alternatively” is preferred to the word “alternately” (unless
you really mean something that alternates). Use the word
“whereas” instead of “while” (unless you are referring to
simultaneous events). Do not use the word “essentially” to
mean “approximately” or “effectively.” Do not use the word
“issue” as a euphemism for “problem.” When compositions
are not specified, separate chemical symbols by en-dashes;
for example, “NiMn” indicates the intermetallic compound
Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of some
composition NixMn1−x.

Be aware of the different meanings of the homophones
“affect” (usually a verb) and “effect” (usually a noun),
“complement” and “compliment,” “discreet” and “discrete,”
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FIGURE 1. Magnetization as a function of applied field. Note that “Fig.” is
abbreviated. There is a period after the figure number, followed by two
spaces. It is good practice to explain the significance of the figure in the
caption.

VI. GUIDELINES FOR GRAPHICS PREPARATION AND
SUBMISSION
A. TYPES OF GRAPHICS
The following list outlines the different types of graphics
published in IEEE journals. They are categorized based on
their construction, and use of color / shades of gray:

1) COLOR/GRAYSCALE FIGURES
Figures that are meant to appear in color, or shades of
black/gray (unless you really mean something that alter-
nates). Such as figures may include photographs, illustra-
tions, graph and multicolor graphs, and flowcharts.

2) LINE ART FIGURES
Figures that are composed of only black lines and shapes.
These figures should have no shades or half-tones of gray,
only black and white.

3) AUTHOR PHOTOS
Head and shoulders shots of authors that appear at the end
of our papers.

4) TABLES
Data charts which are typically black and white, but some-
times include color.

B. MULTIPART FIGURES
Figures compiled of more than one sub-figure are presented
side-by-side, or stacked. If a multipart figure is made up
of multiple figure types (one part is lineart, and another
is grayscale or color), the figure should meet the stricter
guidelines.

C. FILE FORMATS FOR GRAPHICS
Format and save your graphics using a suitable graphics
processing program that will allow you to create the images
as PostScript (PS), Encapsulated PostScript (.EPS), Tagged
Image File Format (.TIFF), Portable Document Format
(.PDF), or Portable Network Graphics (.PNG), sizes them,

TABLE 1. Units for Magnetic Properties

Symbol Quantity Conversion from Gaussian and

CGS EMU to SIa

Φ Magnetic flux 1 Mx → 10−8 Wb = 10−8 V·s

B Magnetic flux density,

magnetic induction

1 G → 10−4 T = 10−4 Wb/m2

H Magnetic field strength 1 Oe → 10−3/(4π) A/m

m Magnetic moment 1 erg/G = 1 emu

→ 10−3 A·m2 = 10−3 J/T

M Magnetization 1 erg/(G·cm3) = 1 emu/cm3

→ 10−3 A/m

4πM Magnetization 1 G → 10−3/(4π) A/m

σ Specific magnetization 1 erg/(G·g) = 1 emu/g → 1

A·m2/kg

j Magnetic dipole

moment

1 erg/G = 1 emu

→ 4π × 10−10 Wb·m

J Magnetic polarization 1 erg/(G·cm3) = 1 emu/cm3

→ 4π × 10−4 T

χ, κ Susceptibility 1 → 4π

χρ Mass susceptibility 1 cm3/g → 4π × 10−3 m3/kg

µ Permeability 1 → 4π × 10−7 H/m

= 4π × 10−7 Wb/(A·m)

µr Relative permeability µ→ µr

w,W Energy density 1 erg/cm3 → 10−1 J/m3

N,D Demagnetizing factor 1 → 1/(4π)

Vertical lines are optional in tables. Statements that serve as captions for
the entire table do not need footnote letters.
aGaussian units are the same as cg emu for magnetostatics; Mx = maxwell,
G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T = tesla,
m = meter, A = ampere, J = joule, kg = kilogram, and H = henry.

and adjusts the resolution settings. If you created your
source files in one of the following programs, you will be
able to submit the graphics without converting to a PS,
EPS, TIFF, PDF, or PNG file: Microsoft Word, Microsoft
PowerPoint, or Microsoft Excel. Though it is not required,
it is strongly recommended that these files be saved in PDF
format rather than DOC, XLS, or PPT. Doing so will protect
your figures from common font and arrow stroke issues that
occur when working on the files across multiple platforms.
When submitting your final paper, your graphics should all
be submitted individually in one of these formats along with
the manuscript.

D. SIZING OF GRAPHICS
Most charts, graphs, and tables are one column wide (3.5
inches / 88 millimeters / 21 picas) or page wide (7.16 inches /
181 millimeters / 43 picas). The maximum depth a graphic
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can be is 8.5 inches (216 millimeters / 54 picas). When
choosing the depth of a graphic, please allow space for a
caption. Figures can be sized between column and page
widths if the author chooses, however, it is recommended
that figures are not sized less than column width unless when
necessary.

There is currently one publication with column mea-
surements that do not coincide with those listed above.
Proceedings of the IEEE has a column measurement of 3.25
inches (82.5 millimeters / 19.5 picas).

The final printed size of author photographs is exactly
1 inch wide by 1.25 inches tall (25.4 millimeters × 31.75
millimeters / 6 picas × 7.5 picas). Author photos printed
in editorials measure 1.59 inches wide by 2 inches tall (40
millimeters × 50 millimeters / 9.5 picas × 12 picas).

Spell out numerals that have no unit of measure or time
(one, two, ... ten), but always use numerals with units of time
and measure. Some examples are as follows: 11 through 999;
1,000; 10,000; twentieth century; twofold, tenfold, 20-fold;
2 times; 0.2 cm; p = .001; 25%; 10% to 25%.

E. RESOLUTION
The proper resolution of your figures will depend on the type
of figure it is as defined in the “Types of Figures” section.
Author photographs, color, and grayscale figures should be at
least 300dpi. Line art, including tables, should be a minimum
of 600dpi.

F. VECTOR ART
In order to preserve the figures’ integrity across multiple
computer platforms, we accept files in the following for-
mats: .EPS/.PDF/.PS. All fonts must be embedded or text
converted to outlines in order to achieve the best-quality
results.

G. COLOR SPACE
The term color space refers to the entire sum of colors
that can be represented within the said medium. For our
purposes, the three main color spaces are Grayscale, RGB,
and CMYK (cyan/magenta/yellow/black). RGB is represent
red, green and blue color. RGB is generally used with
on-screen graphics, whereas CMYK is used for printing
purposes.

All color figures should be generated in RGB or CMYK
color space. Grayscale images should be submitted in
Grayscale color space. Line art may be provided in grayscale
OR bitmap color space. Note that “bitmap color space”
and “bitmap file format” are not the same thing. When
bitmap color space is selected, .TIF/.TIFF/.PNG are the
recommended file formats.

H. ACCEPTED FONTS WITHIN FIGURES
When preparing your graphics IEEE suggests that you use of
one of the following Open Type fonts: Times New Roman,
Helvetica, Arial, Cambria, and Symbol. If you are supplying
EPS, PS, or PDF files all fonts must be embedded. Some
fonts may only be native to your operating system; without

the fonts embedded, parts of the graphic may be distorted
or missing.

A safe option when finalizing your figures is to strip out
the fonts before you save the files, creating “outline” type.
This converts fonts to artwork what will appear uniformly
on any screen.

I. USING LABELS WITHIN FIGURES
1) FIGURE AXIS LABELS
Figure axis labels are often a source of confusion. Use
words rather than symbols. As an example, write the quantity
“Magnetization,” or “Magnetization M ,” not just “M .” Put
units in parentheses. Do not label axes only with units.
As in Fig. 1, for example, write “Magnetization (A/m)”
or “Magnetization (A·m−1),” not just “A/m.” Do not label
axes with a ratio of quantities and units. For example, write
“Temperature (K),” not “Temperature/K.”

Multipliers can be especially confusing. Write “Magneti-
zation (kA/m)” or “Magnetization (103 A/m).” Do not write
“Magnetization (A/m) × 1000” because the reader would not
know whether the top axis label in Fig. 1 meant 16000 A/m
or 0.016 A/m. Figure labels should be legible, approximately
8 to 10 point type.

2) SUBFIGURE LABELS IN MULTIPART FIGURES AND
TABLES
Multipart figures should be combined and labeled before
final submission. Labels should appear centered below each
subfigure in 8 point Times New Roman font in the format
of (a) (b) (c).

J. FILE NAMING
Figures (line artwork or photographs) should be named
starting with the first 5 letters of the author’s last name.
The next characters in the filename should be the number
that represents the sequential location of this image in your
article. For example, in author “Anderson’s” paper, the first
three figures would be named ander1.tif, ander2.tif, and
ander3.ps.

Tables should contain only the body of the table (not
the caption) and should be named similarly to figures,
except that ‘.t’ is inserted in-between the author’s name
and the table number. For example, author Anderson’s
first three tables would be named ander.t1.tif, ander.t2.ps,
ander.t3.eps.

Author photographs should be named using the first five
characters of the pictured author’s last name. For exam-
ple, four author photographs for a paper may be named:
oppen.ps, moshc.tif, chen.eps, and duran.pdf.

If two authors or more have the same last name, their
first initial(s) can be substituted for the fifth, fourth, third...
(unless you really mean something that alternates) letters of
their surname until the degree where there is differentiation.
For example, two authors Michael and Monica
Oppenheimer’s photos would be named oppmi.tif, and
oppmo.eps.
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K. REFERENCING A FIGURE OR TABLE WITHIN YOUR
PAPER
When referencing your figures and tables within your paper,
use the abbreviation “Fig.” even at the beginning of a sen-
tence. Do not abbreviate “Table.” Tables should be numbered
with Roman Numerals.

L. CHECKING YOUR FIGURES: THE IEEE GRAPHICS
ANALYZER
The IEEE Graphics Analyzer enables authors to pre-
screen their graphics for compliance with IEEE Journal of
Microwaves standards before submission. The online tool,
located at http://graphicsqc.ieee.org/, allows authors to up-
load their graphics in order to check that each file is the
correct file format, resolution, size, and colorspace; that no
fonts are missing or corrupt; that figures are not compiled in
layers or have transparency, and that they are named accord-
ing to the IEEE Journal of Microwaves naming convention.
At the end of this automated process, authors are provided
with a detailed report on each graphic within the web applet,
as well as by email.

M. SUBMITTING YOUR GRAPHICS
Because IEEE will do the final formatting of your paper,
you do not need to position figures and tables at the top and
bottom of each column. In fact, all figures, figure captions,
and tables can be placed at the end of your paper. In
addition to, or even in lieu of submitting figures within your
final manuscript, figures should be submitted individually,
separate from the manuscript in one of the file formats
listed above in Section VI-J. Place figure captions below
the figures; place table titles above the tables. Please do
not include captions as part of the figures, or put them in
“text boxes” linked to the figures. Also, do not place borders
around the outside of your figures.

N. COLOR PROCESSING / PRINTING IN IEEE JOURNALS
All IEEE Transactions, Journals, and Letters allow an author
to publish color figures on IEEE Xplore at no charge, and
automatically convert them to grayscale for print versions. In
most journals, figures and tables may alternatively be printed
in color if an author chooses to do so. Please note that this
service comes at an extra expense to the author. If you intend
to have print color graphics, include a note with your final
paper indicating which figures or tables you would like to
be handled that way, and stating that you are willing to pay
the additional fee.

VII. CONCLUSION
A conclusion section is not required. Although a conclusion
may review the main points of the paper, do not replicate
the abstract as the conclusion. A conclusion might elaborate
on the importance of the work or suggest applications and
extensions.

APPENDIX
Appendixes, if needed, appear before the acknowledgment.

ACKNOWLEDGMENT
The preferred spelling of the word “acknowledgment” in
American English is without an “e” after the “g.” Use the
singular heading even if you have many acknowledgments.
Avoid expressions such as “One of us (S.B.A.) would like
to thank ... .” Instead, write “F. A. Author thanks ... .” In
most cases, sponsor and financial support acknowledgments
are placed in the unnumbered footnote on the first page, not
here.

REFERENCES AND FOOTNOTES
A. REFERENCES
References need not be cited in text. When they are, they
appear on the line, in square brackets, inside the punctuation.
Multiple references are each numbered with separate brack-
ets. When citing a section in a book, please give the relevant
page numbers. In text, refer simply to the reference number.
Do not use “Ref.” or “reference” except at the beginning
of a sentence: “Reference [3] shows ....” Please do not use
automatic endnotes in Word, rather, type the reference list at
the end of the paper using the “References” style.

Reference numbers are set flush left and form a column
of their own, hanging out beyond the body of the reference.
The reference numbers are on the line, enclosed in square
brackets. In all references, the given name of the author
or editor is abbreviated to the initial only and precedes
the last name. Use them all; use et al. only if names are
not given. Use commas around Jr., Sr., and III in names.
Abbreviate conference titles. When citing IEEE transactions,
provide the issue number, page range, volume number, year,
and/or month if available. When referencing a patent, provide
the day and the month of issue, or application. References
may not include all information; please obtain and include
relevant information. Do not combine references. There must
be only one reference with each number. If there is a URL
included with the print reference, it can be included at the
end of the reference.

Other than books, capitalize only the first word in a
paper title, except for proper nouns and element symbols.
For papers published in translation journals, please give
the English citation first, followed by the original foreign-
language citation See the end of this document for formats
and examples of common references. For a complete dis-
cussion of references and their formats, see the IEEE style
manual at www.ieee.org/authortools.

B. FOOTNOTES
Number footnotes separately in superscripts (Insert | Foot-
note).1 Place the actual footnote at the bottom of the column
in which it is cited; do not put footnotes in the reference list

1It is recommended that footnotes be avoided (except for the
unnumbered footnote with the receipt date on the first page).
Instead, try to integrate the footnote information into the text. If
you do use them follow this format, allow the automatic sequential
numbering, and use 8 point text.
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(endnotes). Use letters for table footnotes (see Table I). Use
Times Roman 8 for the font size.

VIII. SUBMITTING YOUR PAPER FOR REVIEW
A. REVIEW STAGE USING WORD 6.0 OR HIGHER
If you want to submit your file with one column electroni-
cally, please do the following.

Vertical lines are optional in tables. Statements that serve
as captions for the entire table do not need footnote letters.
aGaussian units are the same as cg emu for magnetostatics;
Mx = maxwell, G = gauss, Oe = oersted; Wb = weber,
V = volt, s = second, T = tesla, m = meter, A = ampere,
J = joule, kg = kilogram, H = henry.

– First, click on the View menu and choose Print Layout.
– Second, place your cursor in the first paragraph. Go to

the Format menu, choose Columns, choose one column
Layout, and choose “apply to whole document” from
the dropdown menu.

– Third, click and drag the right margin bar to just over
4 inches in width.

The graphics will stay in the “second” column. Make the
graphic wider to push out any text that may try to fill in next
to the graphic.

B. FINAL STAGE USING WORD 6.0
When you submit your final version (after your paper has
been accepted), print it in two-column format, including fig-
ures and tables. You must also send your final manuscript on
a disk, via e-mail, or through a Web manuscript submission
system as directed by the society contact. You may use
Zip for large files, or compress files using Compress, Pkzip,
Stuffit, or Gzip.

Also, send a sheet of paper or PDF with complete contact
information for all authors. This information will be used
to send each author a complimentary copy of the journal in
which the paper appears. In addition, designate one author
as the “corresponding author.” This is the author to whom
proofs of the paper will be sent. Proofs are sent to the
corresponding author only.

C. REVIEW STAGE USING SCHOLARONE
MANUSCRIPTS
Contributions to the Transactions, Journals, and
Letters may be submitted electronically on IEEE’s on-
line manuscript submission and peer-review system,
ScholarOne Manuscripts. You can get a listing
of the publications that participate in ScholarOne
at http://www.ieee.org/publications standards/publications/
authors/authors submission.html First check if you have
an existing account. If there is none, please create a new
account. After logging in, go to your Author Center and
click “Submit First Draft of a New Manuscript.”

Along with other information, you will be asked to select
the subject from a pull-down list. Depending on the journal,
there are various steps to the submission process; you must
complete all steps for a complete submission. At the end

of each step you must click “Save and Continue”; just
uploading the paper is not sufficient. After the last step, you
should see a confirmation that the submission is complete.
You should also receive an e-mail confirmation. For inquiries
regarding the submission of your paper on ScholarOne
Manuscripts, please contact oprs-support@ieee.org or call
+1 732 465 5861.

ScholarOne Manuscripts will accept files for review in
various formats. Please check the guidelines of the specific
journal for which you plan to submit.

You will be asked to file an electronic copyright form im-
mediately upon completing the submission process (authors
are responsible for obtaining any security clearances). Failure
to submit the electronic copyright could result in publishing
delays later. You will also have the opportunity to designate
your article as “open access” if you agree to pay the IEEE
open access fee.

D. FINAL STAGE USING SCHOLARONE MANUSCRIPTS
Upon acceptance, you will receive an email with specific
instructions regarding the submission of your final files.
To avoid any delays in publication, please be sure to
follow these instructions. Most journals require that final
submissions be uploaded through ScholarOne Manuscripts,
although some may still accept final submissions via email.
Final submissions should include source files of your ac-
cepted manuscript, high quality graphic files, and a formatted
pdf file. If you have any questions regarding the final
submission process, please contact the administrative contact
for the journal.

In addition to this, upload a file with complete contact
information for all authors. Include full mailing addresses,
telephone numbers, fax numbers, and e-mail addresses.
Designate the author who submitted the manuscript on
ScholarOne Manuscripts as the “corresponding author.” This
is the only author to whom proofs of the paper will be sent.

E. COPYRIGHT FORM
Authors must submit an electronic IEEE Copyright Form
(eCF) upon submitting their final manuscript files. You can
access the eCF system through your manuscript submission
system or through the Author Gateway. You are responsible
for obtaining any necessary approvals and/or security clear-
ances. For additional information on intellectual property
rights, visit the IEEE Intellectual Property Rights department
web page at http://www.ieee.org/publications standards/
publications/rights/index.html.

IX. IEEE PUBLISHING POLICY
The general IEEE policy requires that authors should only
submit original work that has neither appeared elsewhere
for publication, nor is under review for another refereed
publication. The submitting author must disclose all prior
publication(s) and current submissions when submitting a
manuscript. Do not publish “preliminary” data or results.
The submitting author is responsible for obtaining agreement
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of all coauthors and any consent required from employers
or sponsors before submitting an article. The IEEE Journal
of Microwaves Department strongly discourages courtesy
authorship; it is the obligation of the authors to cite only
relevant prior work.

The IEEE Journal of Microwaves Department does not
publish conference records or proceedings, but can publish
articles related to conferences that have undergone rigorous
peer review. Minimally, two reviews are required for every
article submitted for peer review.

X. PUBLICATION PRINCIPLES
The two types of contents of that are published are; 1) peer-
reviewed and 2) archival. The Transactions and Journals
Department publishes scholarly articles of archival value as
well as tutorial expositions and critical reviews of classical
subjects and topics of current interest.

Authors should consider the following points:

1) Technical papers submitted for publication must ad-
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